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Softver

• Visual Studio Community 2022 (17.13)

• Visual Studio Code

• SQL Server 2019 (2017) Express

• SQL Server Management Studio Express

• Docker Desktop
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Uvod u ASP.NET core MVC web aplikacije



ASP.NET core

• ASP.NET core je besplatan, open-source web framework

• Modularan je i radi na Windows, Linux i macOS operativnim sistemima

• Trenutna verzija je ASP.NET Core 9.x i deo je .NET 9 platforme

• Distribuira se kao deo .NET SDK-a (skup alata potrebnih za razvoj i pokretanje 
.NET aplikacija) i putem NuGet paketa

• Omogućava kreiranje web aplikacija i Web API-ja

• Lako se integriše sa različitim klijentskim tehnologijama

• Podržava MVC (Model-View-Controller) obrazac
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MVC pattern
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Models

Modeli su klase koje 
predstavljaju podatke i 
poslovnu logiku 
aplikacije.

Views

Pogledi su komponnete 
generišu korisnički 
interfejs i prikazuju 
podatke korisniku.

MVC patern uključuje sledeće komponente:

Controllers

Kontroleri su komponente koje 
upravljaju korisničkim zahtevima, 
rade sa modelom i odabiraju 
pogled kojem prosleđuju podatke.



Kreiranje ASP.NET Core web aplikacije -1
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Kreiranje ASP.NET Core web aplikacije -2
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Kreiranje ASP.NET Core web aplikacije -3
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Struktura ASP.NET Core web aplikacije
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Folder aplikacije
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Fajl .csproject
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Desni klik na projekat → opcija „Edit Project File"

<Project Sdk =" Microsoft.NET.Sdk.Web " >

<PropertyGroup >
<TargetFramework >net9.0 </ TargetFramework >
<Nullable >enable </ Nullable >
<ImplicitUsings >enable </ ImplicitUsings >

</ PropertyGroup >

</ Project >

.csproj fajl je konfiguracioni fajl koji definiše podešavanja projekta, verziju .NET platforme i zavisnosti (pakete) 
koje projekat koristi.



Folder properties fajl launchSettings.json
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launchSettings.json je konfiguracioni fajl koji definiše kako se ASP.NET Core aplikacija pokreće u 
razvojnom okruženju.



Prikaz profila za pokretanje aplikacije
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• Profilima za pokretanje se pristupa preko opcije "Properties" → "Debug" (Launch Profiles)
• Profil za pokretanje aplikacije definiše način na koji se aplikacija pokreće tokom razvoja 

(protokol, port, okruženje i dodatna podešavanja)



Folder wwwroot

• U folderu wwwroot čuvaju se statički fajlovi (CSS, 
JavaScript, slike itd.)

• Svi fajlovi u folderu wwwroot dostupni su klijentu putem 
HTTP zahteva

• Novi projekat sadrži biblioteke jQuery i Bootstrap
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Dodavanje klijentskih biblioteka

• Desni klik na folder lib → opcija "Add Client-Side Library"
ili

• U meniju Project → opcija "Add Client-Side Library"
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cdnjs.com
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cdnjs je Content Delivery Network (CDN) koji hostuje popularne klijentske biblioteke i 
omogućava njihovo učitavanje putem linka bez lokalne instalacije.



Dodavanje serverskih biblioteka
U meniju Project → Manage NuGet Packages
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Serverske biblioteke se dodaju putem NuGet Package Manager-a



Fajl .csproj
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<Project Sdk =" Microsoft.NET.Sdk.Web " >

<PropertyGroup >
<TargetFramework >net9.0 </ TargetFramework >
<Nullable >enable </ Nullable >
<ImplicitUsings >enable </ ImplicitUsings >

</ PropertyGroup >

<ItemGroup >
<PackageReference Include =" Microsoft.Data.SqlClient " Version =" 6.1.4 " />

</ ItemGroup >

</ Project >

U .csproj fajlu je vidljivo da je instalirana serverska biblioteka Microsoft.Data.SqlClient putem NuGet-a.



www.nuget.org
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Dependency Injection container

• Servis je klasa koja pruža određenu funkcionalnost i koristi se u 
drugim klasama

• Dependency Injection (DI) kontejner je komponenta koja upravlja 
kreiranjem i ubacivanjem zavisnosti u aplikaciji

• ASP.NET Core ima ugrađen Dependency Injection kontejner

• Servis se mora registrovati u DI kontejneru pre korišćenja

• DI kontejner automatski kreira instancu servisa i ubacuje je u 
konstruktor zavisne klase
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Middleware

• ASP.NET Core koristi middleware za obradu HTTP zahteva

• Middleware pipeline je cevovod middleware komponenti kroz koji prolazi 
HTTP zahtev i odgovor

• Svaka middleware komponenta može obraditi zahtev i proslediti ga 
sledećoj komponenti

• Middleware se konfiguriše u fajlu Program.cs

• Redosled dodavanja middleware komponenti određuje tok obrade 
zahteva i odgovora

• Redosled je važan za sigurnost, performanse i funkcionalnost aplikacije
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Cevovod(pipeline) obrade zahteva
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Cevovod(pipeline) obrade zahteva

• ASP.NET Core koristi cevovod (pipeline) za obradu HTTP zahteva

• HTTP zahtev ulazi u cevovod middleware komponenti

• Svaka middleware komponenta može obraditi zahtev i proslediti ga sledećoj 
komponenti

• Nakon obrade, odgovor se vraća nazad kroz isti cevovod obrnutim redosledom

• Ako middleware ne prosledi zahtev dalje (ne pozove next()), prekida se dalja 
obrada (short-circuiting)

• Redosled middleware komponenti određuje tok obrade zahteva i odgovora
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Fajl Program.cs
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var builder = WebApplication .CreateBuilder( args );

// Add services to the container.
builder.Services.AddControllersWithViews();

var app = builder.Build();

// Configure the HTTP request pipeline.
if (!app.Environment.IsDevelopment())
{

app.UseExceptionHandler( "/Home/Error" );
app.UseHsts();

}

app.UseHttpsRedirection();
app.UseRouting();

app.UseAuthorization();

app.MapStaticAssets();

app.MapControllerRoute(
name: "default" ,
pattern: " { controller =Home} / { action =Index } / { id ? } " )
.WithStaticAssets();

app.Run();



Fajl Program.cs

• Prvo se kreira instanca klase WebApplicationBuilder korišćenjem 
statičke metode CreateBuilder klase WebApplication

• Zatim se u kolekciju servisa aplikacije dodaju MVC usluge korišćenjem 
metode AddControllersWithViews

• Metoda Build() objekta WebApplicationBuilder kreira instancu 
WebApplication

• Nakon toga se konfiguriše middleware cevovod obrade HTTP zahteva

• Zatim se konfigurišu endpointi za rutiranje

• Pozivom metode Run startuje se web aplikacija
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Novi hosting model

• ASP.NET Core (od .NET 6) koristi minimalni hosting model

• U starom modelu konfiguracija je bila podeljena između fajlova 
Startup.cs i Program.cs

• Minimalni hosting model objedinjuje konfiguraciju servisa i 
middleware-a u jednom fajlu (Program.cs)

• Podrazumevano se koristi ugrađeni Kestrel web server

26



Kestrel web server
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• Više aplikacija ne može istovremeno koristiti istu IP adresu i port
• Zbog toga se za hostovanje više aplikacija koristi reverse proxy server

• Kestrel se često koristi iza reverse proxy servera (IIS, Nginx, Apache)
• Reverse proxy prima HTTP zahteve sa interneta i prosleđuje ih Kestrelu
• Reverse proxy omogućava hostovanje više aplikacija na istoj IP adresi i portu
• Reverse proxy omogućava da više aplikacija bude dostupno preko iste IP adrese i porta 

tako što zahteve prosleđuje različitim internim portovima



Prvo pokretanje ASP.NET Core web aplikacije
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Prvo pokretanje ASP.NET Core web aplikacije

• Aplikacija se pokreće izborom launch profila (npr. http ili IIS Express)
• Klikom na Run ( ) Visual Studio pokreće aplikaciju
• Pokreće se web server (podrazumevano Kestrel)
• Aplikacija počinje da osluškuje HTTP zahteve na definisanom portu
• Automatski se otvara web pregledač sa URL adresom aplikacije
• Project → (http / https) 

• Pokreće se direktno Kestrel 

• Project → IIS Express pokreće se:
• IIS Express
• Kestrel
• IIS Express prosleđuje zahteve Kestrelu
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Kestrel server – log pri pokretanju aplikacije
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• Kestrel server je pokrenut
• Aplikacija sluša na definisanim portovima
• Prikazan je režim rada (Development)



Prikaz aplikacije u browseru
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• Aplikacija je uspešno pokrenuta na adresi https://localhost:7240
• Zahtev iz browsera obrađuje Kestrel server

https://localhost:7240/


ViewData i ViewBag



Klasa HomeController.cs
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public class HomeController : Controller
{
        
    public IActionResult Index()
    {
        return View();
    }    
}



Index pogled klase HomeController
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@{
    ViewData["Title"] = "Home Page";
}

<div class="text-center">
<h1 class="display-4">Welcome</h1>
<p>Learn about <a href="https://docs.microsoft.com/aspnet/core">building Web apps with ASP.NET 

Core</a>.</p>
</div>



ViewData

• ViewData je mehanizam u ASP.NET Core za prenos podataka iz 
kontrolera u pogled bez korišćenja posebnog modela

• ViewData je svojstvo kontrolera tipa ViewDataDictionary

• Koristi se za jednosmernu komunikaciju (kontroler → pogled)

• Namenjen je prenosu jednostavnih podataka potrebnih samo za 
prikaz

• Implementiran je kao rečnik tipa Dictionary<string, object>

• Ključevi su stringovi

• Pri čitanju podataka u pogledu potrebno je kastovanje ako vrednost 
nije string

35



Prosleđivanje podataka Index pogledu 
HomeController klase

Ako se u akciji pozove samo return View(); bez navođenja imena pogleda, 
ASP.NET Core automatski vraća pogled koji ima isto ime kao akcija (u ovom 
slučaju Index).
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public IActionResult Index()

{

ViewData["brojPonavljanja"]= 5;

ViewData["poruka"] = "Uvod u ASP.NET Core web aplikacije";

return View();

}



Pogled Index.cshtml
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@{

ViewData["Title"] = "Home Page";

}

<div class="row">

<div class="col-6">

@for (int i = 0; i < (int)ViewData["brojPonavljanja"]; i++)

{

<span>Poruka: @ViewData["poruka"]</span><br />

}

</div>

</div>



Generisani html

38



ViewBag

• ViewBag omogućava prenos podataka iz kontrolera u pogled 
bez korišćenja modela

• Koristi se za jednosmernu komunikaciju (kontroler → pogled)

• ViewBag je dinamički objekat (dynamic)

• Svojstva se definišu dinamički u toku izvršavanja

• Ne zahteva eksplicitno kastovanje pri čitanju vrednosti

• Interno koristi ViewData (predstavlja dinamički omotač oko 
ViewDataDictionary)
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Definisanje dinamičkih svojstava
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public IActionResult Index()
{
    ViewBag.brojPonavljanja = 5;
    ViewBag.poruka = "Uvod u ASP.NET Core web aplikacije";         
    return View();
}



Pogled Index.cshtml
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<div class="row">

    <div class="col-md-6">

@for (int i = 0; i < ViewBag.brojPonavljanja; i++)

        {

            <span>Poruka: @ViewBag.poruka</span><br />

        }

    </div>

</div>



Prosleđivanje podataka metodi 
kontrolera



Kreiranje praznog MVC kontrolera
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Imenovanje kontrolera
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Klasa PozdravController
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public class PozdravController : Controller
{
    public IActionResult Index()
    {
        return View();
    }
}



Index metoda klase PozdravController
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public IActionResult Index()
{

ViewBag.poruka = "Zdravo";
return View();

}



Index pogled PozdravController klase 
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Desni klik unutar metode Index pa opcija Add-> View



Folder Views/Pozdrav
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Index.cshtml pogled klase PozdravController
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@{
    ViewData["Title"] = "Pozdrav";
}

<h1>Pozdrav-Index</h1>

<div class="row">
    <div class="col-6">
        @ViewBag.Poruka
        <br />

<a href="/Home/Index">Pocetna</a>
    </div>

</div>



Poziv Index akcione metode klase 
PozdravController posredstvom url adrese
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http://localhost:5024/pozdrav

http://localhost:5024/pozdrav

http://localhost:5024/pozdrav/index

http://localhost:5024/pozdrav/index

• Ruta je definisana kao {controller}/{action}
• Ako se akcija ne navede, podrazumevano se poziva Index
• Zato oba URL-a pozivaju istu akciju

http://localhost:5198/pozdrav
http://localhost:5198/pozdrav
http://localhost:5198/pozdrav
http://localhost:5198/pozdrav
http://localhost:5198/pozdrav
http://localhost:5198/pozdrav/index
http://localhost:5198/pozdrav/index
http://localhost:5198/pozdrav/index
http://localhost:5198/pozdrav/index


Akciona metoda Pozdrav1 PozdravController 
klase

public IActionResult Pozdrav1(int id = 1)
{

ViewBag.BrojPonavljanja = id;
ViewBag.Poruka = "Dobar dan";
return View();

}
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• Akciona metoda Pozdrav1 prima parametar id sa podrazumevanom vrednošću 1
• Ako se vrednost ne navede u URL-u, koristi se ta podrazumevana vrednost



Kreiranje pogleda Pozdrav1

52



Pogled Pozdrav1.cshtml
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@{

ViewData["Title"] = "Pozdrav1";

}

<h1>Pozdrav1</h1>

<div>

<ul>

@for (int i = 0; i < ViewBag.BrojPonavljanja; i++)

{

<li>@ViewBag.Poruka</li>

}

</ul>

</div>



Poziv Pozdrav1 akcione metode
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Prosledjivanje parametara akcionoj metodi
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http://localhost:5000/pozdrav/pozdrav1/5

• U adresi/pozdrav/pozdrav1/5 vrednost 5 se mapira na 
parametar id u metodi Pozdrav1(int id)

• Mapiranje se vrši na osnovu rute:{controller}/{action}/{id?}

http://localhost:5000/pozdrav/pozdrav1/5


Query string

• Query string je deo URL adrese koji dolazi nakon znaka ? i koristi se za 
prosleđivanje podataka serveru u obliku key=value parova

• Više parametara se razdvaja znakom &
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/pozdrav/pozdrav1?id=5&ime=Marko



Korišćenje query stringa
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http://localhost:5000/pozdrav/pozdrav1?id=5

• Parametar se može proslediti i putem query stringa
• U adresi/pozdrav/pozdrav1?id=5 vrednost 5 se mapira na parametar id akcione 

metode
• ASP.NET Core automatski povezuje naziv parametra u URL-u (id) sa parametrom 

metode (int id)

http://localhost:5000/pozdrav/pozdrav1?id=5


Pitanje 1
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Odgovor: c

Servisi  u terminologiji ASP.NET Core web aplikacija su:

a. Klase ASP.NET Core web aplikacije koje zavise od drugih klasa

b. Klase izvedene iz klase Controller

c. Klase od kojih zavise druge klase ASP.NET Core web aplikacije



Pitanje 2
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Odgovor: a

Registracija servisa - dodavanje servisa u kolekciju servisa aplikacije kod ASP.NET Core 9

aplikacija, vrši se unutar 

a. Fajla Program.cs

b. Fajla appsettings.json

c. Fajla launchSettings.cs



Pitanje 3
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Odgovor: a

Cevovod (pipeline) za protočnu obradu HTTP zahteva u ASP.NET Core 9 web aplikacijama 

konfiguriše se unutar:

a. Fajla Program.cs

b. Fajla appsettings.json

c. Fajla launchsettings.cs



Pitanje 4
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Odgovor: a

ASP.NET Core web aplikacija ima ugrađen Dependency Injection kontejner koji:

a. Ubacuje objekat klase servisa u zavisnu klasu

b. Ubacuje pogled u ASP.NET Core web aplikaciju

c. Ubacuje kontroler u ASP.NET Core web aplikaciju



Pitanje 5
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Odgovor: c

Statički fajlovi kod ASP.NET Core web aplikacija čuvaju se unutar sledećeg foldera:

a. Models

b. Data

c. wwwroot
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